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Introduction

In India, oral cancer is a major public health concern, 
where it is one of the country’s top three cancers (Elango 
et al., 2006). Amongst the various types of oral cancer, oral 
squamous cell carcinoma (OSCC) is the most common 
making up almost 80% of all cancers in the oral cavity. 
OSCC has a high age-adjusted rate in India, at 20 per 
100,000 people, and accounts for more than 30% of all 
cancers in the country (Sankaranarayanan et al., 2005). 
Early detection of OSCC decreases the mortality rate for 
the disease to 80%-90% (Wang et al., 2014). As most of the 
OSCC cases are asymptomatic in the early stages, timely 
identification of these lesions requires vigilant screening 
of high- risk individuals such as tobacco users, alcoholics, 
immunocompromised individuals, for the presence and 
progression of any potentially malignant disorders (PMD). 
Interventions provided to individuals at the stage of PMDs, 
prevents the development of OSCC and decreases the 
mobidity and mortality rates of the individual. In line 
with the principals of early detection, several studies 
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have been focused on identifying features the predict the 
transformation of a lesion from dysplasia to neoplasia. It 
is established that the development and differentiation of 
neoplastic tissue requires coordinated cross-talk between 
the cells of the epithelium and mesenchyme (Desmoulière 
et al., 2004). The stromal components not only act as 
a nutrient source for the tumor cells but also deter the 
progression of malignant cells. Proteolytic remodelling 
of the extracellular matrix promotes tumour growth by 
facilitating tumour cell invasion, which leads to changes 
in the collagenous stroma (Rich et al., 2005). 

Histopathology is the gold standard for obtaining 
important prognostic information, such as, dysplasia and 
cancer grade, that can help clinicians make treatment 
decisions. The lack of agreement among various 
observing pathologists regarding the subjective aspects of 
histological grading, and may not provide adequate risk 
stratification or management advice (Warnakulasuriya 
et al., 2008; Lumerman et al., 1995; Kujan et al., 2007). 
This coupled with the limited availability of skilled 
pathologists in the more rural regions of the country has 
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further emphasized the importance of utilizing newer 
methods and technologies for a more quantitative, 
consistent, and accurate diagnosis in order to aid clinical 
decision-making, improving head and neck carcinoma 
(HNC) patient survival and reducing the disease burden 
on the health care system.

Computer assisted diagnostics is one of the major 
researches focuses in the field of histopathology recently, 
owing to the advances in high-throughput tissue bank and 
archiving of digitized histological slides. Of this, image 
analysis has been an area of extensive study in cancer 
diagnostics research (Reyes-Aldasoro et al., 2013). It is 
based on digital image analysis and processing, which 
entails extracting useful information from images in 
order to delineate clinically important characteristics 
(segmentation) or classify lesions (Litjens et al., 2017; 
Shen et al., 2017). By explicitly describing a prior set of 
features and processing processes, a number of ad hoc 
feature analysis-based machine learning (ML) techniques 
have been proved to be successful in various diagnostic 
applications (Panayides et al., 2020).

The value of quantitative analysis of pathology images 
has been acknowledged by researchers in both the image 
analysis and pathology domains. The aim of the study 
was to evaluate the efficacy of a novel image analysis-
based method to predict the biological behavior of oral 
premalignant and malignant lesions based on the ratio of 
collagen staining in the oral mucosal lesions.

Materials and Methods

In this hospital based, retrospective study, a total 
of 45 histopathologically diagnosed sections under 
three categories- Normal tissues obtained from the peri 
coronal region associated with impacted third molars 
(n=15), Premalignant lesions (n-15), Oral squamous cell 
carcinoma (n=15) were included. The paraffin- embedded 
tissue blocks were retrieved from the archives. Sections of 
5µm thickness were made and mounted on the glass slide. 
The slides were deparaffinized, rehydrated and subjected 
to routine H and E staining and a differential staining 
technique- Herovici’s stain.

Herovici’s staining technique
The stain was prepared as a mixture of 0.1% w/v 

acid fuchsin in picric acid and 0.05% w/v methyl blue 
(sigma- Aldrich) in 1% v/v acetic acid solutions at a 2:1 
ratio. The slides were incubated in this solution for 5 
minutes and then differentiated in 1% acetic acid for 2 
minutes, followed by a 5-minute wash in 100% ethanol. 
The slides were then dehydrated through alcohol and 
mounted with DPX.

The stained slides were viewed under 10x magnification 
in the microscope and images were captured using 2MP 
camera attached to the microscope. The images were 
classified, transferred and stored in the computer for 
image analysis.

Image analysis
The Image J software was used for the quantification 

of collagen fibers in the histological slides. The image 

analysis was carried out in 4 steps- Image acquisition, 
Scale setting, Deconvolution and Quantification. The 
stained slides were viewed under 10x magnification and 
images were captured using a 2MP camera attached to the 
microscope. All photos were saved in a 24-bit RGB tagged 
image file format (tiff) with a resolution of 640 480 pixels. 
To set the scale for the analysis, The known distance of the 
scale bar was first measured using the “straight line” tool 
in the “analyze” menu. The value was then entered into the 
“known distance” and corresponding unit of µm was set 
in the “Unit of length” box under the set scale menu. The 
images were split into the red, blue and green components 
by performing an orthonormal transformation of the it’s 
RGB information (Katsuda et al., 1992). The uploaded 
images were converted to RGB by selected “RGB color” 
option in the “Type” box under the “Image” menu (Figure 
1).  Following this, the converted images can be separated 
into the differently stained components by entering the 
“Image” menu and selecting the “Color deconvolution2” 
command (Figures 2 and 3). To measure the area covered 
by the blue fibers the area covered by the fibers were first 
delineated using the “threshold” command in the “Adjust” 
box under the “Image” menu (Figure 4). The selected area 
was manually adjusted until the complete are covered by 
the blue fibers were selected. Following which the area 
to be measured was set under the “Analyze” menu in the 
“Set measurement” tool by clicking on “Area” and “Limit 
to threshold”. The results would now be displayed in the 
results window by simply clicking on the “measurement” 
function under the “Analyze” menu (Figure 5). The same 
procedure is repeated the measure the area covered by the 
Type I collage fibers that are stained red in color (Chen 
et al., 2017).

Statistical analysis
Data was then statistically analyzed using Kruskal- 

Wallis test with the SPSS software. A value of P < 0.05 
was considered statistically significant.

Results

In the present study, diagnosis based on the routine 
H and E-stained slides revealed that of the 15 cases 
categorized as premalignant lesions, 6 cases were 
diagnosed as mild dysplasia, 5 cases as moderate 
dysplasia, 4 cases were severe dysplasia. Under the 
oral squamous cell carcinoma category, 9, 4 and 2 cases 
were categorized as well differentiated squamous cell 
carcinoma, moderately differentiated squamous cell 
carcinoma and poorly differentiated squamous cell 

Test Statisticsa,b

Collagen Type I Collagen Type III
Chi-Square 23.978 30.428
df 2 2
Asymp. Sig. 0 0

† Kruskal-Wallis ANOVA, two sided P.value<0.05

Table 1. Kruskal- Wallis Test of Significance for the 
amount of Type I and Type III Collagen in Premalignant 
and OSCC Group
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type III (blue stain) collagen fibers, with type I still being 
more in quantity then type III. Analysis of the OSCC 
group showed a marked change in the distribution of the 
collagen fibers with the sections exhibiting predominantly 
blue staining of the collagen fibers (Figure 6). The 
quantification of the type I and type III collagen fibers 

carcinoma respectively, based on their H and E slides. 15 
normal H and E slides were taken as control.

The control tissues showed predominantly red staining 
of the collagen fibers indicative of type I collagen. All the 
grades of dysplasia in the premalignant group showed a 
slight shift in the ratio between the type I (red stain) and 

Figure 1. RGB Colour Space Conversion of Images on Image J Software

Figure 2. Colour Deconvolution Plugin 

Figure 3. a, Polychrome stained section of moderately differentiated SCC showing differential staining of collagen 
fibres; b,c&d, Red, blue and green components of 3a following colour deconvolution
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present in both the groups and subsequent statistical 
analysis via Kruskal- Wallis test, a significant difference 
was noted in the distribution of type I and type III collagen 
fibers between the premalignant and the oral squamous 
cell carcinoma group (P<0.05) (Table 1).

Discussion

Epithelial mesenchymal transition (EMT) has also 
been implicated as a major player in the progression 

and metastatic transformation of oral squamous cell 
carcinoma. The extracellular matrix is important for tissue 
growth, regulation, differentiation, and structure. The 
stromal cells can retain control over cell growth, function, 
and response to wounds and other pathologic situations by 
modifying the ECM (Shetty et al., 2015). The mechanical 
quality of the stroma is largely determined by its collagen 
concentration, and this is considered a major barrier to be 
crossed during invasion, allowing infiltrating cell mass 
to enter (van den Hooff et al., 1988). The content of the 

Figure 4. Threshold Value Adjustment for the Blue Stained Collagen Fibres in MDSCC 3a

Figure 5. Measurement of Area Covered by Fibres in the Region of Interest.

Figure 6. Distribution of Collagen Type I and Type III in Normal, PMD and OSCC Groups.
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stroma varies from one condition to another.  Under normal 
conditions; collagen type I, composed of mature, thick and 
closely packed fibers makes up 90% of the stroma whereas 
type III collagen, a more immature, thin fibrillar variant 
occupies 8-10% (Berkovitz et al., 2009; Montes et al., 
1991). Inflammation is promoted by dysplastic epithelial 
cells, which produce growth factors, hormones, cytokines, 
and proteinases such as MMP leading to a change in the 
stromal characteristics (Aggarwal et al., 2006). This study 
aims to quantitatively analyze the change in the stroma, 
particularly the collagen content, in both dysplastic and 
carcinomatous lesions. 

Many differential staining techniques are available to 
evaluate, detect, and measure stromal tissue and collagen. 
Traditional stains for detecting collagen, such as the 
Masson trichrome, Van Gieson techniques and Picrosirius 
red, have their own drawbacks. They have inherent flaws, 
such as a lack of specificity for thin collagen strands 
or require specialized equipment such as polarized 
microscopes for their viewing. In the present study, we 
used the Herovici’s polychrome staining technique, that 
stains both mature and immature collagen fibers red 
and blue respectively. This eliminates the need for any 
expensive, specialized technique or equipment for the 
purpose of collage fiber analysis. 

Though histopathology remains the gold standard 
for the diagnosis of lesions, it is wrought with inter and 
intra- observer variability. Artificial intelligence in the 
form of image analysis helps us quantify the subjective 
components in histopathologic diagnosis. In the present 
study, we quantified the amount of type I and type III 
collagen in the stroma using Image J software and 
compared the contents in both premalignant lesions and 
oral squamous cell carcinoma lesions. The variation of 
stromal composition in regards to the type of collagen 
was statistically significant with oral squamous cell 
carcinoma showing predominantly type III collagen. 
Premalignant lesions show comparatively lesser amount of 
type I collagen but still more than type III, than the normal 
tissues. The results obtained in the current study has been 
able to quantitatively prove the subjective conclusions 
drawn in several previous studies regarding the change 
in stromal collagen composition (Fuentes et al., 2012; 
Venigella et al., 2010; Yokoyama et al., 2003; Arora et 
al., 2018; Varghese et al., 2015).  

The mechanism behind this change in collagen 
formation is still unclear. A few studies suggest that the 
state of hypoxia seen during the transition from epithelial 
dysplasia to oral squamous cell carcinoma causes 
genetic instability and increases angiogenesis, thereby 
making the stroma edematous and unstable. Following 
this the carcinoma cells change collagen by producing 
Carcinoma Associated Fibroblasts (CAFs) and increasing 
collagenolytic enzyme activity as the cancer advances. 
The generation of altered collagen is aided by the changed 
fibroblast phenotype (Daley et al., 2008). Another study 
stated that chronic inflammation linked to dysplasia could 
be one of the causes of collagen fiber disorganization and 
loose packing. The anaplastic cells in the lesion secrete 
cytokine that attract innate immune cells, which produce 
MMPs and reactive oxygen species that can result in 

deterioration of extracellular matrix collagen (Varghese 
SS et al., 2015). 

In conclusion, the findings of our study suggest that 
there is a significant difference in the collagen composition 
of the stroma as the lesion evolves from dysplasia into 
oral squamous cell carcinoma. The prognosticative value 
of collagen in the aggressiveness of oral lesions has 
been studied recently. This study has utilized a simple 
differential staining technique and image analysis to 
quantify the amount of collagen present without the need 
for any special training, Expensive molecular techniques 
or elaborate time- consuming procedures that ultimately 
delays the diagnosis for the patient. Artificial intelligence 
makes a rapid, quantitative and bias free pathologic 
diagnosis a reality.  
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